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Introduction to “NSave for Desktops”

NSave is a service provided by Information Services that utilizes the software program CPP
(CrashPlanPro). CPP is one of the most widely acclaimed backup solution deployed across an
institution. To make the system as user friendly as possible, Information Services has customized
this particular offering for common “desktop” computer systems within UNL.  Highlights of this
system include:

Very convenient way to back up your critical data files on your personal computer.

No need to worry about changing tapes, Full or Incremental backups, tape rotation policies,
broken tape drives, or off-site storage.

Users can retrieve their files on their own, anytime day or night. If assistance is required,
however, trained support staff are available during normal University hours of operation.

Erased files can be retrieved up to 6 months from the date they were erased.

To allow Information Services to inform you of issues related toward NSave, the electronic
mail address of each NSave subscriber is added to an electronic mailing list.



CPP Installation Instructions

The following instructions will guide you through the process required to install CPP on your
desktop computer. Please review the instructions before beginning, and if you are not
comfortable with any phase of the installation, please ask for assistance. Simple questions will be
answered by the NSave Support Specialist. If you desire, an NSave Support Specialist will install
this product for you for a $10 charge. Contact the NSave Support Specialist at 402-472-6843.

1. Minimum System Requirements for CPP version 7.4.0

In order to use CPP, you will need a computer that meets the following requirements:
A 1 GHZ+ 64 —bit Intel CPU running, MacOSX 10.13, 10.14 and 10.15
750 MB of available disk space.

1 GB of memory.
A connection to UNL’s computer network.

2. Begin CPP Installation

A. Using your web browser (Safari, Mozilla Firefox, etc...) go to the URL address
http://nsave.unl.edu/nsave-self-install. Click on the Macintosh Installer. The following
steps will differ depending on which web browser you are using. Please refer to the
section on using Safari or Mozilla Firefox if you are using one of those browsers. If you
are using a different browser and need assistance in downloading the installer contact the
NSave Support Specialist at 402-472-6843.

B. Using Safari:

The download window will appear and start downloading the installation file..

Save As: NSave_GrashPlan_7.4.0.pkg

Where: i Downloads

Format: Document

Proceed to step D to continue the installation
C. Using Mozilla Firefox:

A window will appear and let you open the file or save it, leave the bullet on Open
with and click OK.



[ ] Opening NSave_CrashPlan_7.4.0.pkg

You have chosen to open:
w NSave_CrashPlan_7.4.0.pkg

which is: Document (170 MB)
from: https:/insave.unl.edu

What should Firefox do with this file?

) Open with  Installer (default) l
Save File

Do this automatically for files like this from now on.

Cancel OK
D. The installer window will appear, click Continue to begin.
@ i Install NSave CrashPlan 8

Welcome to the NSave CrashPlan Installer

» Introduction You will be guided through the steps necessary to install this

software.

Destination Select

Installation Type

Installation

Summary Start the installation
of CrashPlan select
Continue.

Continue




E. The install window opens and it is recommended not to change the location of the program
for future upgrades. Click on the name of the hard drive and then Continue.

[ ] ‘& Install NSave CrashPlan

Select a Destination

Introduction Select the disk where you want to install the NSave
CrashPlan software.
Destination Select

Installation Type Click on the hard drive

and click Continue

%

Macintosh HD
71.79 GB available
120.1 GB total

Installation

Summary

Installing this software requires 6.1 MB of space.

You have chosen to install this software on the disk
“Macintosh HD".

&

name

N
Go Back

-

Continue

F. You will be prompted for the computer password to authorize the installation.

password and click Install Software.

Installer is trying to install new software. Type
your password to allow this.

Username: admin

Password:

Cancel nstall Software

Type in the




G.  There will be a progression bar and when the installation is done you will see it completed
successfully. Select Close.

The installation was completed successfully.

Introduction
Destination Select
Installation Type
Installation

Summary The installation was successful.

The software was installed.

Close

H.  The next window will be Sign In to Code42 CrashPlan. Since you are a new user click on
Sign up for an account at the bottom of the window. The username is your myunl email address
and the password is the password linked to your myunl email address.

G copEaz

Sign in to Coded2

l. You will need to select the campus your myunl email address is associated with.



Sign in to Code4?2

J. You have finished the installation and configuration of CrashPlan Pro. In the Welcome

window click on the Manage Files button to select what drive, folders and files you want to
backup.

B Codes2

File Edit View Tools Help

Ecobeaz
ITS-1D5DW12

ITS-IDSDW12 Backup Set — Manage Flles... &

K. Inthe Manage Files window click in the box in front of the drives, directories, file (S) you
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want to back up. It is recommended to select all local drives for the backup since there is
unlimited storage space with Code42’s cloud environment. When you have made your selections
click on Save.

5 Code42 CrashPlan =Hiel X

File Edit View Tools Help

<
olelg|lg |B|x|z

®

g

After selecting what to backup click on the Save button.

—

3. You are Finished.

You have now successfully completed the installation of CPP. You can drag the
UNL_CrashPlan.pkg icon to the trash.

You can make an alias of the CPP program to put on your desktop for easier access. Open the hard
drive and expand the Applications folder. Find the CrashPlan icon in the list.

Click on it once and from the menu across the top of the window select File and scroll to Make
Alias. You will now have an alias of CPP in the Applications folder you can move to your desktop
Backing Up Your Computer

A. Your computer will automatically backup. If you want to back up a certain file (s)
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manually you will need to open the CPP program. To open the program click on the CPP
icon in the system tray or from the hard drive open the Applications folder and then
CrashPlan.

B.  When the program opens you will be at the Welcome window. To select what to back up
click on the Manage Files button.

I Coded2 - u] x f
File Edit View Tools Help
'
[ copEea2 {tHome L Downloads {5}Setings t
ITS-IDSDW12
Manage Flles.. &

ITSAD5DW12 Backup Set —

Internet2 US

Click on Manage Files ta open
the window to select what
you want to backup.

C. Click in the box in front of the directories or file (s) you want to backup. Once you have
made your selections click on the Save button save the selections.



5 Code42 CrashPlan =RECE X

File Edit View Tools Help

<
TrrErRFRR
o ] g 4 B N =

After selecting what to backup click on the Save button.

—

After clicking Save, you can close the window and CrashPlan will run in the background. The
software will start scanning your computer to make a catalogue of the files on it. Once the scan is
done it will start backing up. The first backup is usually the longest since it backups all the data
after that the backups are incremental and only back up changed files.

Backup Notes

= The first time you backup your computer, it may take an hour or more for the backup to
complete (all of the appropriate files need to be backed up the first time). For most
computers with “typical” files, all future backups should take less than a few minutes.

= Backups run once a day when your computer is on and connected to the UNL-network.

= You will not even notice the backup running as you work since it automatically lowers the
process priority while you are on your computer.

= You can run a manual backup if you have an important file(s) that you want to backup but
don’t want to wait for the next scheduled backup.
C.
= You will automatically receive a daily email report of the status of your backup.

= Any backed up files marked inactive by CPP will still be retrievable from the backup server
for 6 more months.

Restoring Files to Your Computer
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The following examples step you through the most common way of restoring a few files. If you
don’t feel comfortable restoring the files yourself, or need to restore as many files as possible
(perhaps your hard drive went bad), contact the NSave Support Specialist at (402) 472-6843.

A. Click on the CrashPlanPro icon in your system tray or from the hard drive select the
Applications folder then CrashPlan.

B. The program will open and you will be at the Welcome window.
C. Click on the Restore Files button to select what computer to restore from.
G Coded2 - O X
S coDE42 {yHome L Downloads ¢C}Settings
ITS-IDSDW12 .

ITS-ID5DW12 Backup Set —

Internet2 US
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D. In the Restore files window there are three icons to assist in selecting what you want to
restore. A search icon, a calendar icon and other.

& codet2 - o X
File Edit View Tools Help

I coDEa2 ) Home 4 Downloads {5}Settings

Display Hidden or
DeletedFiles

Calendar icon

Restore files from: Internet2 US J’
, 4
v € > Users > searehcon ——>Q  AsOfTodayB e+
Name - Size Date Modified
B 3D Objects — 09/24/18 07:09 AM
W AcpDa — 09/08/15 10:41 AM
I Application Data - 10/2318 10:36 AM
BoxEditinstaller.exe aMB 07/01/14 07:56 AM
Bm Commvault — 05/26/15 10:46 AM
Bl Coneas — 09/24/18 07:09 AM
Bl Cookies — 04/02/18 11:49 AM
B Deskiop - 10/23/18 1103 AM
B Dacuments — 101218 1139 AM
Done

E. The Search icon allows you to search for a file if you know the name but are not sure where
it was saved on the hard drive. In the Search window type in the name of the file. You can
use * as a wild card if you do not know the complete name of the file.

S Codet2 CrashPlan [E=IEA)
File Edit View Tools Help
{r Home L
Q| ® As Of Today EH
nter a term, phrase, or file extension to start your search
Type in the name of the file you want to search for. You can use
the * symbol as a wild card if you do not know the name. \L
Don:
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F. The Calendar icon allows you to select a different date to restore from.

June 2016 >

13 14 15 16 17 18

20 21 22 23 24 25 ¢

26 27 28 29E

59 || PM Most Current

G. The additional icon lets you select to display deleted or hidden files. This is helpful is you
accidentally deleted a folder or file and you want to restore it.

5 Code42 CrashPlan o B %

File Edit View Tools Help

£} Home

) ome 4 Downloads
Clickin on ... allows you to show deleted or hidden
files.

Get files from Internet2 US Q  AsOfToday &

V' Ci> Users > v Include deleted fles

Show hi
BE AcpData 9/08/15 10:41 AM
| [ Application Data 6/08/16 8:28 AM
BoxEditinstaller.exe 4MB 7/0114 7:56 AM

5/26/15 10:46 AM

- 2/1016 7:28 AM

5/23/16 3:17 PM

6/29/16 9:04 AM
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H. To select what folders or files you want to restore click in the box in front of the name of the folder or
file.  When you have selected all the folder or files you want to restore click on the Restore Files

button.

G codeaz
File Edit View Tools Help

EcopEaz2

Restore files from: Internet2 US

~  C > Users >

Name

B 3D Objects e
“ | AppData
~ [ Application Data

BoxEditinstaller.exe

Bm commvaui

Bm Coniaas

B Cookies

Bm Deskiop

B Nociments

Folders: 5519 Files: 22290 Total Size: 7 GB

Click in the box in
front of the folder or
file you want to
restore. When you
have made your
selactions click on the
Restore Files button
to start the restore.

) Home

Q

Size

4MB

L Downloads {C}Settings

As Of Today [

Date Modified
09/24/18 07:09 AM
09/08/15 10:41 AM
10/23/18 10:36 AM
07/01/14 07:56 AM
05/26/15 10:46 AM
09/24/18 07:09 AM
04/02/18 1148 AM
10/23/18 11:03 AM

NAAR 1139 AM

4

I.  After clicking on Restore Files the Options window opens. Here you have the options of Save
selected files to, If file already exists and Permissions.

I3 Code42 CrashPlan

= EI&

file Edit View Tools Help

Get Files Options

Save selected files to:

If file already exists:

nioad v
Rename v
e M
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J.  Save selected files has a pop box that allows you to select where to save the restore to, Desktop,
Downloads, Original Location and Other, which allows you to select a specific place on your hard
drive.

I3 Code42 CrashPlan SHACH X ]
File Edit View Tools Help

Get Files Options

Save selected files to: Downioads 54
If file already exists: ' Downloads
Permissions

anee ﬂ

K. If file already exists lets you choose to either Rename or Overwrite the restored file.

I3 Code42 CrashPlan =<

File Edit View Tools Help

Get Files Options

Save selected files to Downloads v

If file already exists: Rename v
v Rename

Permissior
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L. Permissions is a pop box where you can select either Current or Original.

IS Coded? CrashPlan ) [

File Edit View Tools Help

Get Files Options

Save selected files to Downloads v
if file already exists: Rename v
Permissions Current 52

¥ Current

M. After you have set the options for the restore click on the Go button and the restore will begin.

2 Code42 CrashPlan ! =

File Edit View Tools Help

Get Files Options

Save selected files to: Downloads v
If file already exists: Rename b2

Permissions

Once you have set the options you
want click on the Go button to start
the restore.
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CrashPlan Settings

At the top of the window click on Code42 CrashPlan to view the Preferences. Preferences allows
you select different settings for your CrashPlan account.

(LA C Ul File Edit View Window Help = = o B Friol
About Code42 CrashPlan | ]

Code42 CrashPlan
Preferences... %,

Hide Code42 CrashPlan  3H

Hide Others X #8H
Show All
Quit #Q Device Preferences ®

General Usage Destinations Network Security

Device Name:

Device ID:

Language: Automatic v
Show Code42 CrashPlan status in menu bar (@
Open Code42 CrashPlan in menu bar on login (@

Manage account on the web.

e The General preference list details about the device.

Device Preferences O]

General Usage Destinations Network Security

Device Name: admin's MacBook Pro Rename...

Device ID: 751104129764758534

Language: Automatic w
—

Show Coded2 CrashPlan status in menu bar (. .\'

Open Code42 CrashPlan in menu bar on login @

Manage account on the web...
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e Usage is where you can set the number of days before sending email alerts if the device has
not backed up. Also the CPU and battery usage.

e Destinations list where the device is backing up to.

|5 Code42 CrashPlas

File Edit View Tools Help

Device Preferences ®
General Usage Destinations Network Security
| Intemet2 US Internet2 US Connected
I
Spaceused:  43GB Run Maintenance
1
Quot

Delete Archive.
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e Network shows the WAN and LAN settings.

e Security is where you can set a password or encryption. If you set a password note that if
the password is ever lost restores can’t be performed.

File Edit View Tools Help

Device Preferences ®

General Usage Destinations Network Security

‘.

Require account password to open the Code42 CrashPlan App

Account Encryption Key Security Upgrade
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e Under the File Menu you can select Replace Device which allows you to replace an old
device with this one. It will sync backed up data of an old device with this new device.
Also you can Pause Code42 CrashPlan backup.

EB Edit View Window Help & D . T u o Fist

Add Backup Se 2N |
Close Window 8w | Code42 CrashPlan
———————Under the File menu dlick on Replace

Pause Code42 CrashPlan Device if this computer is replacing a
different computer.

Replacing a device is a three step process.

o5 10 your new

settings to your new device

Transferring files can take some time. We'll walk you through the steps

Cancel Start.

e Under the Window menu there is the History setting. This lists details about the backup.

Edit \fgm Help & =4 Oy
Minimize 8M

Code42 CrashPlan

Zoom
) Home Code42 CrashPlan Under the Window menu there is the History L Download
History X %H < option which lists the details about the backup.
K Code42 CrashPlan History
History
Date Message

07/15/16 09:09 AM Code42 Code42 CrashPlan started, version 5.2.0, GUID 751104129764758534
» 07/15/16 09:09 AM [admin’s MacBook Pro Backup] Scanning for files to back up
07/15/16 09:09 AM Backup scheduled to always run
07/15/16 09:09 AM [admin’s MacBook Pro Backup] Starting backup to Internet2 US: 111 files (107.10MB) to back up

[admin’s MacBook Pro Backup] Stopped backup to Internet2 US in 37 minutes: 19,575 files (897.50MB)

07/15/16 09:46 AM backed up, 421.50MB encrypted and sent @ 2.5Mbps (Effective rate: 3.8Mbps)

07/15/16 09:46 AM - Reason for stopping backup: The backup destination was disconnected

07/15/16 09:50 AM [admin’s MacBook Pro Backup] Starting backup to Internet2 US: 67,031 files (5GB) to back up
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Most of the configuration is done on the CrashPlan server and unless a problem arises the defaults
will work. If you want to make changes please consult the NSave Support Specialist at 472-6843
or email nsave@unl.edu.
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